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RA2E2 Group 

RA2E2 HS3001 Sensor Device Example  
Introduction 
This document describes a Renesas microcontroller RA2E2 application for an HS3001 sensor device using 
the RA2E2 Fast Prototyping Board. 

Target Device 
RA2E2 

When applying the sample program covered in this document to another microcomputer, modify the program 
according to the specifications for the target microcomputer and conduct an extensive evaluation of the 
modified program. 
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1. Description 
1.1 Abstract 
The HS3001 sensor device sample is a precision digital sensor featuring indoor temperature, humidity using 
the RA2E2 Fast Prototyping Board.  

The RA2E2 Fast Prototyping Board comes equipped with a high-performance RA2E2 microcontroller. It is an 
evaluation board specialized for prototype development for a variety of applications. It has a built-in emulator 
circuit that is equivalent to an E2 emulator Lite so you can write/debug programs without additional tools. In 
addition, with Arduino Uno and Pmod™ interfaces included standard and through-hole access to all pins of 
the microcontroller, and other features, it is highly expandable. 

The HS3001 is a highly accurate, fully calibrated relative humidity and temperature sensor. The high 
accuracy, fast measurement response time, and long-term stability, along with the small package size, 
makes the HS3001 ideal for a wide number of applications from portable to harsh environments. An 
integrated calibration and temperature compensation logic provides fully corrected RH and T values via a 
standard I²C output. The measured data is internally corrected and compensated for accurate operation over 
a wide range of temperature and humidity levels–user calibration is not required. 

1.2 Specifications and Main Technical Parameters 
1.2.1 Technical Parameters 
• Power Supply: USB power supply (5 V)  

• Operating Voltage (MCU): 3.3 V 

• Operating Temperature: Ambient temperature 

 
1.2.2 Specifications 
• Function: Detect indoor humidity and temperature with US082-HS3001EVZ 
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2. RA2E2 Microcontroller 
2.1 RA2E2 Block Diagram 
Figure 1 shows the block diagram of RA2E2 (24-pin products). 

 

Figure 1.   RA2E2 Block Diagram 

2.2 Key Features 
• Arm® Cortex®-M23 core 

 Arm®v8-M architecture 
 Maximum operating frequency: 48 MHz 
 Arm Memory Protection Unit (Arm MPU) with 8 regions 
 Debug and Trace: DWT, FPB, CoreSight™ MTB-M23 
 CoreSight Debug Port: SW-DP 

• Memory 
 Up to 64-KB code flash memory 
 2-KB data flash memory (100,000 program/erase (P/E) cycles) 
 8-KB SRAM 
 Memory protection units 
 128-bit unique ID 
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• Connectivity 
 Serial Communications Interface (SCI) × 1 

• Asynchronous interfaces 
• 8-bit clock synchronous interface 
• Simple IIC 
• Simple SPI 
• Smart card interface 

 Serial Peripheral Interface (SPI) × 1 
 I3C bus interface (I3C) × 1 

• Analog 
 12-bit A/D Converter (ADC12) 
 Temperature Sensor (TSN) 

• Timers 
 General PWM Timer 16-bit (GPT16) × 6 
 Low Power Asynchronous General Purpose Timer (AGTW) × 2 
 Watchdog Timer (WDT) 

• Safety 
  SRAM parity error check 
  Flash area protection 
  ADC self-diagnosis function 
  Clock Frequency Accuracy Measurement Circuit (CAC) 
  Cyclic Redundancy Check (CRC) calculator 
  Data Operation Circuit (DOC) 
  Port Output Enable for GPT (POEG) 
  Independent Watchdog Timer (IWDT) 
  GPIO readback level detection 
  Register write protection 
 Illegal memory access detection 

• Security and Encryption 
  AES128/256 
  True Random Number Generator (TRNG) 

• System and Power Management 
  Low power modes 
  Event Link Controller (ELC) 
  Data Transfer Controller (DTC) 
  Key Interrupt Function (KINT) 
  Power-on reset 
  Low Voltage Detection (LVD) with voltage settings 

• Human Machine Interface (HMI) 
  AES128/256 
  True Random Number Generator (TRNG) 

• Multiple Clock Sources 
  High-speed on-chip oscillator (HOCO) (24/32/48/64 MHz) 
  Middle-speed on-chip oscillator (MOCO) (8 MHz) 
  Low-speed on-chip oscillator (LOCO) (32.768 kHz) 
  Clock trim function for HOCO/MOCO/LOCO 
  IWDT-dedicated on-chip oscillator (15 kHz) 
  Clock out support 

• Up to 20 pins for general I/O ports 
  5-V tolerance, open drain, input pull-up 

• Operating Voltage 
  VCC: 1.6 to 5.5 V 
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• Operating Temperature and Packages 
 Ta = -40℃ to +85℃ 

• 24-pin HWQFN (4 mm × 4 mm, 0.5 mm pitch) 
• 20-pin HWQFN (4 mm × 4 mm, 0.5 mm pitch) 
• 16-pin WLCSP (1.84 mm × 1.87 mm, 0.4 mm pitch) 

 Ta = -40℃ to +105℃ 

• 24-pin HWQFN (4 mm × 4 mm, 0.5 mm pitch) 
• 20-pin HWQFN (4 mm × 4 mm, 0.5 mm pitch) 
• 16-pin WLCSP (1.84 mm × 1.87 mm, 0.4 mm pitch) 

 Ta = -40℃ to +125℃ 

• 24-pin HWQFN (4 mm × 4 mm, 0.5 mm pitch) 
• 20-pin HWQFN (4 mm × 4 mm, 0.5 mm pitch) 
• 16-pin WLCSP (1.84 mm × 1.87 mm, 0.4 mm pitch) 

 
2.3 Pin Assignments 
Figure 2 shows the pin assignments of RA2E2 (24-pin products). 

 

Figure 2.   RA2E2 (24-Pin Products) Pin Assignments 

3. System Outline 
3.1 Principle Introduction 
The HS3001 Sensor Device uses an RA2E2 microcontroller and a digital temperature and humidity sensor. 
Users can check the sensing data through Window -> Show View -> Expression in e2 studio after the MCU 
(RA2E2) detects the indoor temperature/humidity. Figure 3 shows the system composition. Figure 4 shows 
the RA2E2 FPB PMOD Interface. Figure 5 shows the connection of the RA2E2 FPB and the Relative 
Humidity Sensor Pmod™ Board (US082-HS3001EVZ). 
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I3C

RA2E2 FPB 
RTK7FPA2E2S00001BE

US082-HS3001EVZ

 

Figure 3.   System Composition 

 

Figure 4.   RA2E2 FPB PMOD Interface 
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RA2E2 Fast
Prototyping Board

P400/SCL0Note

P401/SDA0Note

MCU Board

SCL
SDA

US082-HS3001EVZ

1
2

Note: As P400 and P401 are used as I3C interface which communicates 
with US082-HS3001EVZ, it is needed to enable Type 6A IIC functions 
on the FPB-RA2E2 board. Please ensure that the on board links of E4 
and E5 are closed and links of E3 and E6 are open.  

Figure 5.   Connection of RA2E2 FPB and US082-HS3001EVZ 

3.2 Peripheral Functions to be Used 
Table 1 lists the peripheral functions to be used and their usage. 

Table 1. Peripheral Functions to be Used 

Peripheral Function Usage 
I3C  Get data (temperature, humidity) from the sensors. 
 

3.3 Pins to be Used 
Table 2 lists the pins to be used and their function. 

Table 2. Pins to be Used 

Pin Name Description 
P400/SCL0 Clock signal: Communicate with sensor (HS3001) through I3C-bus 
P401/SDA0 Data signal: Communicate with sensor (HS3001) through I3C-bus 
VDD Power supply voltage 
GND Ground 
 
3.4 Operating Instructions 
1. Once powered on, the system begins to initialize. 
2. After initialization, the MCU (RA2E2) starts to get the sensor measurement result. 
3. The MCU (RA2E2) starts the next measurement. 
 

4. Hardware 
This section describes how the RA2E2 Fast Prototyping Board measures the temperature and humidity via 
US082-HS3001EVZ.  

About the details of US082-HS3001EVZ, please refer to the following link. 

https://www.renesas.com/jp/en/products/sensor-products/humidity-sensors/us082-hs3001evz-relative-
humidity-sensor-pmod-board-renesas-quick-connect-iot 

Figure 6 shows the hardware composition. Figure 7 shows the RA2E2 FPB board layout (top side). 
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Figure 6.   Hardware Composition 

 

Figure 7.   RA2E2 FPB Board Layout (Top Side) 
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4.1 Schematics 
Figure 8 shows the schematic of US082-HS3001EVZ via RA2E2 FPB Pmod1 connector. 

 

Figure 8.   US082-HS3001EVZ Circuit 

5. Software 
5.1 Integrated Development Environment 
The sample code described in this chapter has been checked under the conditions listed in the table below. 

Table 3. Operation Check Conditions 

Item Description 
Board FPB-RA2E2 
Device RA2E2 (R7FA2E2A72DNK) 
Operating frequency High-speed on-chip oscillator (HOCO) clock: 48 MHz 

System clock (ICLK): 48 MHz 
Peripheral module clock B (PCLKB): 24 MHz 
Peripheral module clock D (PCLKD): 48 MHz 

Operating voltage 3.3 V (can run on a voltage range of 1.6 V to 5.5 V) 
Integrated development 
environment (e2 studio) 

e2 studio 2022-01 

FSP FSP v3.7.0 from Renesas Electronics Corp. 
Toolchain (GCC ARM Embedded) 10.2.1.20201103 
Project type Flat 
HS3001 Lib HS3000X Temperature/Humidity Sensor (rm_hs300x) 

 

5.2 Operation Outline 
The tasks of the entire system are listed as below: Reset/Initialization and Measurement. 

1. Reset/initialization 
When the system is powered on, it will enter the initialization operation. HS3001 is initialized. Then I3C0 
will be initialized. 

2. Measurement mode 
After initialization, the MCU starts to get the sensor measurement results.  
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You can watch the measurement results through  the Expression window. 

 

Figure 9.   Expression Window in e2 studio 

5.3 Flow Chart 
5.3.1 Main Processing 
Figure 10 shows the flowchart for the main processing routine. 

hal_entry()

Sensor Initialization
sensors_init()

Software Delay (50ms)

Read data from HS3001 

Wait 4 seconds

 

Figure 10.    Main Processing 
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5.4 File Composition 
The file composition is shown in Figure 11. 

   

Figure 11.   File Composition 
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6. How to Add Sensor Middleware using FSP in e2 studio 
1. Launch e2 studio. 
2. Create a new project. 

 

Figure 12.   Create New Project 

3. Add HS3001 sensor middleware in the Stacks tab. 

 

Figure 13.   Add to Stacks Tab 



RA2E2 Group RA2E2 HS3001 Sensor Device Example 

R01AN6050EC0100  Rev.1.00  Page 14 of 16 
May.13.22  

4. Add r_iic_master or r_sci_i2c according to the specifications of the target board. 

 

Figure 14.   Add r_iic_master or r_sci_i2c 

5. Set the pins to be used. 

 

Figure 15.   Add Pins to be Used 



RA2E2 Group RA2E2 HS3001 Sensor Device Example 

R01AN6050EC0100  Rev.1.00  Page 15 of 16 
May.13.22  

6. Set the properties of I2C Master Driver according to the specifications of the target board. 

 

Figure 16.   Set Properties of I2C Master Driver 
7. How to Build the Project and How to Program the Output File 
7.1 Build in e2 studio 
1. Launch e2 studio. 
2. Right-click on the Project Explorer and select Import from the displayed menu. 
3. The Import window will be displayed. Select Existing project to workspace and click Next. 
4. In the Select root directory form, select the project folder shown in the Project Folder 

RA2E2_FPB_HS3001_App of e2 studio. After selection, confirm that the specified project is displayed in 
Project and click Finish. This closes the Import window. 

5. Right-click on the project displayed on the Project Explorer and select Build Project to start building. 
6. A Motorola S-record file RA2E2_FPB_HS3001_App.srec is generated in the path shown in the Debug 

folder of e2 studio. 
 
7.2 Writing an S-Record file using Renesas Flash Programmer 
This section describes how to write the pre-built Motorola S-record file attached to this application note. 

To write the pre-built .srec file, it is necessary to mount a header component so that the Fast Prototyping 
Board can operate stand-alone. For details, refer to section 5.12 Emulator Reset Header in the RA2E2 Fast 
Prototyping Board User's Manual (R20UT4969). 

1. Launch Renesas Flash Programmer. 
2. Select File -> New Project... from the menu to create a new project of RA2E2 using E2 lite. For the 

connection setting Interface select 2 wire UART, for Power select None. 
3. Press the Browse ... button in Program File on the Operation tab to open the .srec file 

RA2E2_FPB_HS3001_App.srec . 
4. Press the Start button to start writing. 
 
(Please close 2-3 of CN4 when using Renesas Flash Programmer.) 

Note:  For Flash Programming or Debugging with IDE (e2studio), 2-3 pin header of CN3 should be OPEN.  

After Flash Programming, standalone operation w/o IDE can be enabled by setting the 2-3 pin header 
of CN3 to SHORT. 

8. Sample Code 
The sample code is available on the Renesas Electronics website. 
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9. Reference Documents 
The latest versions of these documents are available on the Renesas Electronics Website. 

• RA2E2 Fast Prototyping Board (R20UT4956) 
• RA2E2 User's Manual: Hardware (R01UH0919) 
• RA Family HS300x Sample Application (R01AN5897) 
 
The latest information can be downloaded from the Renesas Electronics Website. 

• Technical Updates/Technical News 
 

Website and Support 
Visit the following URLs to learn about key elements of the RA family, download components and related 
documentation, and get support. 

RA Product Information  www.renesas.com/ra  
RA Product Support Forum  www.renesas.com/ra/forum  
RA Flexible Software Package www.renesas.com/FSP 
  
Renesas Support  www.renesas.com/support 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 
 
 
 
 
All trademarks and registered trademarks are the property of their respective owners. 

http://www.renesas.com/ra
https://www.renesas.com/ra/forum
http://www.renesas.com/FSP
https://www.renesas.com/support
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General Precautions in the Handling of Microprocessing Unit and Microcontroller 
Unit Products 
The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the 
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products. 

1. Precaution against Electrostatic Discharge (ESD) 

A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps 

must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be 

adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity. 

Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and 

measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor 

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices. 
2. Processing at power-on 

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of 

register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external 

reset pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states 

of pins in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power 

reaches the level at which resetting is specified. 
3. Input of signal during power-off state 

Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O 

pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal 

elements. Follow the guideline for input signal during power-off state as described in your product documentation. 
4. Handling of unused pins 

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are 

generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity 

of the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal 

become possible. 
5. Clock signals 

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program 

execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator 

during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal 

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable. 
6. Voltage application waveform at input pin 

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between VIL 

(Max.) and VIH (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the 

input level is fixed, and also in the transition period when the input level passes through the area between VIL (Max.) and VIH (Min.). 
7. Prohibition of access to reserved addresses 

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these 

addresses as the correct operation of the LSI is not guaranteed. 
8. Differences between products 

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems. 

The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in 

terms of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic 

values, operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a 

system-evaluation test for the given product. 
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Notice 
1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products 

and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your 
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use 
of these circuits, software, or information. 

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, 
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this 
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples. 

3. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics 
or others. 

4. You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export, 
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required. 

5. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any 
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering. 

6. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for 
each Renesas Electronics product depends on the product’s quality grade, as indicated below. 
 "Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home 

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc. 
 "High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key 

financial terminal systems; safety control equipment; etc. 
Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas 
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to 
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space 
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics 
disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product 
that is inconsistent with any Renesas Electronics data sheet, user’s manual or other Renesas Electronics document. 

7. No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics 
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but 
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS 
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING 
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE, 
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND 
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT 
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH 
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO 
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE. 

8. When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, “General Notes for 
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by 
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas 
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such 
specified ranges. 

9. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific 
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability 
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics 
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily 
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as 
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for 
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are 
responsible for evaluating the safety of the final products or systems manufactured by you. 

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas 
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of 
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these 
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance 
with applicable laws and regulations. 

11. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is 
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations 
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions. 

12. It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or 
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document. 

13. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics. 
14. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas 

Electronics products. 

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled 
subsidiaries. 

(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.  
(Rev.5.0-1  October 2020)  

Corporate Headquarters  Contact information 
TOYOSU FORESIA, 3-2-24 Toyosu, 
Koto-ku, Tokyo 135-0061, Japan 
www.renesas.com 

 For further information on a product, technology, the most up-to-date 
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